MASTER OF FINE ARTS IN WRITING
VERMONT COLLEGE OF FINE ARTS

Degree Manuscript Instructions

Students ready for the award of the M.F.A. degree must submit a degree manuscript by the end of semester date.
This manuscript must be submitted to the MFA office as an email attachment, in PDF format (some hard copies are

required, see below).

THE PDF VOLUME SHOULD INCLUDE:

STUDENT

Title Page: (see sample for guidelines) which includes the following statement: Submitted in partial
fulfillment of the requirements of the Master of Fine Arts in Writing Program at Vermont College of Fine
Arts. The title page must also be submitted as a hard copy to the MFA office, along with the end of
semester materials — see below. NOTE: the title page in the PDF should have Faculty Advisor and Faculty
Chair names typed onto (as well as underneath, with their titles) the signature lines.
Dual-Genre Students: your title page should include three signatures lines: one for each creative portion’s
faculty advisor (or 2™ reader) and one for the Faculty Chair. Contact office for sample dual-genre title page.
Preface (OPTIONAL. If, for instance, selection of the material included has been limited to half of the work
produced, one might want to make reference to the material excluded and explain the basis for selection;
or, one could refer to the process, the nature of revision, the changes in the work over the course of one's
tenure in the program, etc.).
Table of Contents (see sample for exact guidelines).
Book-length collection of your original creative work (poems, short stories, a novel, CNF essays or
memoir) completed or substantially revised while in the program. Minimum requirements are:
-creative nonfiction or fiction: 75 pages
-poetry: 32 pages
-Dual-genre students must submit both creative theses within the single volume, with either 1 or 2
titles (see “Title Page”). The volume submitted will contain (in two parts: e.g., Part 1. Poetry, Part 2:
CNF) the work of both genres. The creative theses should not be submitted as separate volumes
unless one petitions, and is approved, to do so. If you have any questions please contact the office.
an abstract of the critical thesis, OR the paper itself (this must be included in the pagination and should be
listed in the table of contents — see sample).
a complete alphabetical bibliography, prepared in MLA or Chicago Style, of all books and articles read
during the student's tenure in the Program, whether for semester projects or for residency participation.
This must be included in the pagination and should be listed in the table of contents. A hard copy of the
complete bibliography is also required. The bibliography should NOT be sectioned by genre or semester.

Formatting: The order of contents should be as follows:

-Title page

-Preface (if included)

-Table of contents

-Creative work

-Abstract of critical thesis or critical thesis itself
-Complete bibliography.

Pagination: should be consecutive, beginning with the first page of creative work through the final page of the
complete bibliography (see following pages for more info). The title page, table of contents, and any other initial
pages (such as preface, if included) should not be part of the pagination. Margins should be 17, top, bottom and

sides. Font should be a standard 12 pt font, preferably Times New Roman.

HARD COPIES TO BE SENT WITH THE OTHER END-OF-SEMESTER MATERIALS (see Semester Forms

Checklist for list of all materials required):

= Title Page: (see sample below for exact guidelines, and instructions above). Hard copy title page should

include blank signature lines for actual signatures from Faculty Advisor and Faculty Chair.

= Abstract of the Volume (i.e., a brief description of the contents of the volume, to be used for filing
purposes and not paginated; see sample). Do not include this in the PDF version, hard copy only to

office.

= Ahard copy of the complete bibliography (see above).



Graduates should remember that all materials must be received by the end-of-semester date. The degree cannot
be awarded until the MFA office has received the semester evaluations and the complete pdf volume.

Saving Your Manuscript in Portable Document Format (PDF)
PDF is a format that retains all the elements of a printed document as an electronic image which you can view,
navigate, print, or send to someone else. Please see pagination guidelines at the end of this document.

PDF files are created using Adobe Acrobat, or similar programs. This way the file can be opened in a web browser
like Internet Explorer using the free Adobe Reader software, whether one uses a Mac or Windows-based computer.
It also saves trees and storage space to save them electronically. There are several ways to convert your thesis to
a PDF file.

Adobe Acrobat

You can purchase your own full version of this popular software to create PDF files. View this web page
http://www.adobe.com/products/acrobat/matrix.html to see a chart comparing the various features in
versions of Adobe Acrobat.

Mac OS X

Macintosh computers running on version 10 operating systems have the ability to create PDF files from most of
their applications. This means that you can convert your text document directly from the application you are working
in. Instead of using the Save As... feature you will have to “print” to a file by clicking on File from the menu bar and
then Print from the drop down menu. Within the Print dialog box that appears you will find a button titled Save as
PDF. Once you save your file as a PDF you won’t be able to make changes to it unless you purchase the Adobe
Acrobat software mentioned above.

Microsoft Word 2007 and up....
In the latest versions of Microsoft Word, you have the option of saving a Word file in PDF Format. Click “Save as”
under the Office dropdown menu in the top left corner of the screen — PDF is offered as an option.

Free PDF Creator - PrimoPDF

One way to convert your completed Creative Manuscript file to PDF is to use PrimoPDF, free software available on
the web at http://www.primopdf.com/. Once you have installed the software you can convert your document to
PDF from within any application by simply 'printing' to the PrimoPDF printer. To convert your file please follow these
directions:

1. In the document-authoring program of your choice, select File>Print. The Print dialog window appears.

2. Select the PrimoPDF printer from the list of available printers from the Name: field on the top.

3. Click OK. The Create PDF dialog window appears.

4. Enter a name and select a location for the PDF file.

5. Choose your PDF Settings by clicking on one of the radio buttons. For your manuscript you should choose
Print.

6. Inthe Save As field enter document name.

7. Click OK to save the document as PDF. Once you save your file as a PDF you won’t be able to make

changes to it unless you purchase the Adobe Acrobat software mentioned below.

Some of the new features of this free product that you might like are the ability to create secure PDFs with 40-/128-
bit encryption, allowing the highest level of security for your PDF files. Security settings include password to open,
password to change, disable printing, disable text/graphics copying, disable commenting, disable text editing,
disable page addition. You can also add document information (e.g. title, author, subject, keywords) to converted
PDF files, resulting in faster and easier searching of PDF documents. These two features can be accessed by
clicking on the corresponding buttons on the Create PDF dialog window (see step 3.)

Ask MFAW staff to convert document to PDF

You can also have the MFAW staff convert your thesis to PDF for you for a fee. Just ask the assistant director for
more details.


http://www.adobe.com/products/acrobat/matrix.html
http://www.primopdf.com/

Sample Thesis Title Page

THE DEEDS OF STEPHEN
By Joe Smith

Submitted in partial fulfillment of the requirements of the Master of Fine Arts in Writing Program
at Vermont College of Fine Arts.

July 2012

Jane Doe (leave blank on hard copy) John Smith (leave blank on hard copy)

Faculty Advisor, Jane Doe Faculty Chair, John Smith
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MFA in Writing/Sample Thesis Abstract to be send as a hard copy only — do not include in PDF volume

THE DEEDS OF STEPHEN
By Joe Smith

ABSTRACT OF THE VOLUME

This creative thesis contains five short stories, an abstract of a critical paper, and a full bibliography of
readings completed during my tenure in the Master of Fine Arts Program from July, 2010 through July, 2012.

Of the five short stories, three are considered complete and ready to seek publication. The remaining two
are in progress. Four of the stories were conceived of and written while | was a student in the Program. The fifth,
although first written prior to my entrance to MFA study, has been substantially revised in recent semesters. There
is a common theme that runs through all the enclosed storied and they are arranged here to follow a chronological
progression that leads from one to another.

The abstract of my critical paper, Uses of Rhetorical Statement in Contemporary Poetry, outlines my goals

and conclusions in this study.
The bibliography includes readings completed during my four semester projects, as well as those read for

participation in the two-week residency periods.

July 2012



Pagination your Degree Manuscript

As part of the formatting guidelines for the critical and creative theses, we require that page numbers do not appear
on the title and table of contents pages. If you are unfamiliar with pagination and section breaks in Microsoft Word,
this quick info sheet will show you how to:

- insert a section break between the table of contents page and the first page of your creative work

- unlink document footers of these two new sections

- insert page numbers in the new section footers

Pagination using Word 2007
(for Word 2003 and earlier see pages 9-11.)

Section Breaks

To create pagination that begins after the first page of the document you must create section breaks for

each section you intend to number differently. You can also create a section without numbers for the title

and table of contents pages.

In the Page Layout tab open the i
ord

6J\ ™| (LR "breaks" dropdown menu -t
a3

Home Insert Page Layout Refer 5 Mailings Review View

_‘Ai K ‘ f [y Orientation » *=) Breaks ~ \A] Watermark ~ | Indent Spacing LB o Front = |2 Align ~

= 1A — I:i Size v £ Line Numbers ~ || i Page Color~ | 2= Left: 0 2 :: Before: 0 pt %
Themes Margins __ - - = — T

5= £E Columns ~ b Hyphenation ~ ﬂ Page Borders | = Right: |0° = X; After:  0pt & )
Themes Page Setup % || Page Background Paragraph \F] Arrange
Page Brelﬁs

Page
Mark the point at which one page ends
and the next page begins.

Column
Indicate that the text following the column
break will begin in the next column.

Text Wrapping
Separate text around objects on web
pages, such as caption text from body text.

T mhl—ﬁ _vL

Section Breaks click here

Next Page *—_——-

Insert a section break and start the new
section on the next page.

Wl

Continuous
Insert a section break and start the new
section on the same page.

v

ulll

Even Page
Insert a section break and start the new
=42 section on the next even-numbered page.
i | Odd Page
Insert a section break and start the new
r—=3=. section on the next odd-numbered page.

l




Unlinking the footers

In Word, the default setup links the pages to each of the previous sections. You must unlink the footers
to have page numbers appear only in selected sections.

ﬁ/@ H9-™& - Document3 - Microsoft Word -
- Haome Insert Page Layout References Mailings Review

View
m- D = Ij _ Ell= L[_:"P a “ 2, Hyperlink El;_j Ej 4 A | Signature Line = J-c Q
— = EL] — A& Bookmark = = @Date & Time
Cover Blank Page Table Picture Clip Shapes SmartArt Chart Header Footer Page Text Quick WordArt Drop " . Equation Symbal
Page~ Page Break - Art ~ ['n] Cross-reference > - Number~ || Box~ Parts~ - Cap- ' Object - - -
Pages Tables Illustrations Links Header] ooter Text Symbols

In the Insert menu click on the "footer”
dropdown menu arrow

Built-In -
Blank < Choose the type of footer
you would like ("blank" is a
good option)
[Type test]

Blank (Three Columns)

[Type tea] [Type teet] [Typw tuet]
Alphabet
[Type test]) Page 3
Annual
1

Austere (Even Page)

RN ervoct o test o spactiod sty in document. | [Tyse the compeny same]

|| = Edit Footer

L—_:;{ Remove Footer

=4




Home Insert Page Layout References Mailings Review View I| Design |

@ ElEl E 5, Previous Section Different First Page =+ Header from Top: 0,57 : E
‘ T4 A

E — |_=.l'_T|p Mext Section Different Odd & Even Pages t Footer from Bottom: 0.5 .
‘ooter  Page Date  Quick Picure Clip Goto Goto gz - . Close H
+  Mumber~ | & Time Parts= Art Header Footer @ Link to Prevlu-ug Show Document Text E Insert Alignment Tab and Fc
e e tion J Optians J Position J Clo

You must click here to unlink this
section from the first section. If
you do not unlink, your page
numbers will start on the first
page of your document.

If your focter states this,
it will link the page

numbers to the section \*

before it.
[Type text]
&L!:I I = . eGSOt FR UL TR
@ — peccr |
| Home | Insert Page Layout References Mailings Review View | Design
@ ElE E E"_T: Previous Section Different First Page =+ Header from Top: 0.5" . ﬁ
¢
o — E‘. Mext Section Different Cdd & Even Pages t Footer from Bottom: |0.57 .
Header Footer Fage Date  Quick Picture Clip Goto Goto Close Header
- - Mumber~ || & Time Parts= Art Header Footer '%';—" Link to Previous Show Document Text E Insert Alignment Tab and Footer
Header & Footer " Insert | Mavigation J Options J Pasition J Clase

In the Design menu choose the "page
number" dropdown arrow and choose the
type of numbering you want.

Once you have done this go back into the “page number” dropdown and at the bottom click on “format
page numbers...”

Home Insert Page Layout References Mailings Review View I| Design |
@ ElE E [5R, Previous Section Different First Page =+ Header from Top:  |0.5° s W
M
Lo - |§'> Mext Section Different Odd & Even Pages t Footer from Bottom: |0.57 :
Footer  Page Date  Quick Picture Clip Goto Goto g . . X Close Header
»  Mumber~ | &Time Parts~ Art Header Footer '%l; Link to Previous Show Document Text E Insert Alignment Tab and Footer
ider & Footer J Insert J MNavigation J Options J Position J Close

Page Number Format |E||X|

Mumber Format: |1J 23 .. v|

You need to check this

. . [ tnclude chapter number
circle and click "ok".

Chapter starts with style:  |Heading 1

Lse separator: - (hyphen)

Footer -Section 2- Examples: 1-1, 1-4

Page numbering

0 Continue from previous section

i Ok I[ Cancel J

You have now finished the pagination of your thesis.
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Pagination using Word 2003 and earlier

Insert Section Break

1. Click into the document where you would like to insert the section break.
2. From the menu bar click on Insert.
3. From the drop-down menu that appears please click on Break. A dialog box will appear.
File Edit VYiew | Insert | Format Tools Table
D E e Besk 555
4 Heading 2 + 14 page furbers... E
Date and Time...
J Q ate and lime b i
_— AutoText b —
jﬁ e L

Symbol...

I g Comment

Break types
(" page break
" Column break
" Text wrapping break

Section break types

o Conl;tnuouk
" Even page

" Odd page

OK I Cancel |

4, Click on Next page from the list under Section break types.

5. Click OK. A section break is inserted in the space following your cursor in the document. Anything after that
should automatically move to the next page.



Unlinking Footers

1. In the Menu toolbar, click on View and select Header and Footer.
Edit | View | Insert Format Tools
z Q =] normal F%
ormal 1 Web Layout 12
5 _ Print Layout D
—_— Qutline —
=k 2

Task Pane "
- Toolbars » -

Ruler

Document Map

Header and Footer |

N

i

At the top and bottom of every page you will see a rectangular area designated by a dotted-line, which is the
designated area for the header and footer. The Header and Footer toolbar window will also pop up.

2. Put your cursor in the footer box on the first page of your creative work of the manuscript. If you have
inserted a section break correctly in the previous steps your footer title should say Footer — Section 2 — (see
O D B O o S e e B B Sy SO S e WIS
Al :
below)

Jame as Previous|

Once you unlink the footer from the previous one you can assign new formatting to the footers from there on.
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Inserting Page Numbers

1. Click on Insert in the menu bar and select Page Numbers... The Page Numbers window will appear on your

View Insert | Format Tools Table WWir

e ® oo < | =
GiABeF I PageNAmbers... I B .
Date gﬁd Time... - r
autoText » -
! =il : ! :
screen.
2. Click on the Format...button. The Page Number Format window will appear on your screen.
Position: Preview
|E7v:xttv:|rn of page (Footer) _ﬂ
Alignment: —
[Right =] ———
IV Show number on First page: —_—
Format... | OK I Cancel |
3. Click on the number format of your choice from the Number Format drop down menu.

4. Under Page Numbering please select the Start at: radio button and make sure it is set to 1. 5. Click on the OK

Page Number Format 21 x|

MNumber format:

I” Include chapter number

Chapter starts with style

Use separatar:

Examples:  1-1, 1-A

Page numbering
" Continue from previous section

(% Start at: |1 E‘
OK I Cancel |

button. This will close the Page Number Format dialog box.

5. Click on the OK button to insert the page numbers. Make sure you choose centered for the aliment. Your
footer on the first page of your creative work should look similar to this:
Foaoter_-Section 2-
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